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Abstract
In this lesson we put our toe in the water of the PIC instruction set. We will also explore the MPLAB-X
simulator and see how it can help us understand what is happening in the PIC.
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1. Writing Programs
1.1. Introduction
As we said way back in Lesson 1, we use an assembler to help translate mnemonics for the instructions
and memory locations into the ones and zeroes that the processor needs to do its thing.
In this lesson, we will do a number of experiments using some of the more basic instructions in the PIC.
These instructions manipulate the working register (W) and the file register (F).

1.2. Setting up the project
Begin by setting up a project, just as you did in Lesson 3, section 2, "Setting Up a Project". Call the project
Lesson4a. Once again, select Simulator for the tool.
And again, just like in Lesson 3, add a file to the project called Lesson4a.asm.
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Our First Program

2. Our First Program
2.1. Introduction
The project consists of a number of files. If you look in the Lesson4a.X folder with Windows Explorer,
you will see two files and two folders at this point. The Lesson4a.asm file is the one we are currently
interested in. The Makefile contains the top level instructions for building the project. The nbproject
folder contains more detailed instructions for building the project. The debug folder will be used to store
simulator results.

Figure 1. Initial Project Folder

2.2. A note about make
When you click on the Build Main Project button, a number of things happen:
• MPASM assembles your .asm file resulting in a .o file.
• MPLINK links the .o file resulting in a .cof file.
• MP2HEX converts the .cof file to a .hex file.
All these steps are not terribly interesting for our initial, pretty tiny, programs, but they become helpful as
projects get more complex.
make compares dates on all the files in the project and figures out the minimum number of steps
necessary to bring the .hex file up to date.
In addtion to these files, a number of other files are produced containing things like symbols needed for
debugging, error messages, listings, etc.
When you click on the Build Main Project button, make does what it does, basically makes the .hex file
up to date.
If you click on it a second time without doing anything else, all that will happen is the dates will be
checked, but no files will be changed.

Figure 2. Build results if nothing changed
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Clicking on Clean and Build Main Project button deletes all the intermediate files and then does the
make.

Figure 3. Clean and Build Main Project button

Figure 4. Clean and Build results
The Makefile in the main project folder contains a number of dummy targets, allowing the advanced
user to do specific things outside the capabilities of MPLAB-X. The files in the nbproject folder are
replaced any time there is a change to the project, and thus should not be edited.
These capabilities are intended for the advanced developer working on a large project. For this course,
simply click on the Clean and Build Main Project button and ignore all the fluff.

2.3. Basics
In the previous lesson, we mentioned that there are three columns the assembler cares about. These
columns are separated by spaces and/or tabs. The assembler doesn't care about how many or which you
use. From the assembler's point of view, a single space is the same as four spaces and three tabs. For us
humans, though, it is nice to have the columns line up, and generally that is easier if we favor tabs.
The first column must start inthe first character position on the line, and is called the label. A label is
simply a name we give to something in our program that we might want to reference later. We actually
don't need labels. We could refer to everything by it's address, but that could get kind of messy as we
make changes to the program and move things around. Labels let us refer to things with terms that we
find helpful.
The second column is the opcode. This is the actual instruction to the PIC of what we want it to do.
Some instructions need something to operate on. For example, we might want to store something in a
particular location. The third column is the operand, the thing we want the instruction to work on.
Besides instructions, there are assembler directives. Rather than instructions to the PIC. these are
instructions to the assembler.
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Assembling the program
In almost all of our programs, we are going to need a basic five directives:

Figure 5. Basic directives
The processor directive tells the assembler which type of PIC we are using. The include directive
tells the assembler to include a file which contains definitions for a number of symbols relevant to that
processor. The __config directive tells the processor that we will be using a crystal (_HS_OSC), we want
the watchdog timer turned off (_WDT_OFF), we want the power-up timer enabled (_PWRTE_ON) and we
won't be using low power programming (_LVP_OFF).
The org tells the assembler where in the PIC's memory we want the code to be placed, and the end
directive marks the end of our program.
Enter this program into the editor, check that the colors match those in Figure 5, “Basic directives”, and
click the Save All button.

Figure 6. Save All toolbar button

2.4. Assembling the program
When you click on the Clean and Build Main Project the result should be similar to Figure 4, “Clean
and Build results”. When you build a project, the important bits are in color. What you hope to see is:

If there was a problem, you will see

When diagnosing errors, look for colored lines. Black lines in the output are commands that were issued.
Blue and red lines indicate problems found. Green is good.

3. Adding Some Instructions
3.1. Introduction
Now that we have the basic skeleton for all programs, we can go ahead and work over the actual
instructions for our program. In this lesson, we aren't going to do a lot useful. Our point here is to get to
understand how some of the basic instructions work.

3.2. Our first instructions
We are going to begin with the simplest of instructions. When we enter instructions, we place them after
the org directive and before the end directive. For our experiments right now, we need a nop instruction
right before end. This is the simplest of instructions, it does nothing!
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Let's add two more instructions before our nop, a movlw D'5' and a clrw instruction. These instructions
move the number 5 into the W register, then clear it. Our program should now look like this:

Figure 7. Very simple program

3.3. Let's see what happens
Once we get the program to assemble correctly, we want to see whether it does what we expect.
We can have the simulator run our program by clicking the Debug Main Program button.

Figure 8. Debug Main Program toolbar button
After some activity, much of it flying by faster than we can see, we might be left with something like:

Figure 9. First Debug Results
That really wasn't terribly helpful. What happened?
Well, the simulator ran our program. The program loaded a 5 into the W register, then cleared that same
register, then executed a no-operation instruction, then ran off into never-never land. It never did anything
we can see.

6

The Debug Toolbar

3.4. The Debug Toolbar
When we started the simulator, a number of new toolbar buttons showed up. These control the simulator.
During the next few steps we will use these buttons:

Figure 10. Simulator/Debugging Toolbar
Click on the Stop Debugging button to end this simulator session.

3.5. Breakpoints and Stepping
If we want to understand what our program is doing, we need to be able to stop it at key places, and step
through it instruction by instruction. We tell the simulator to stop at a particular instruction by putting a
breakpoint on that instruction.
Click on the line number to the left of the movlw instruction. The line should become highlighted in red.

Figure 11. Breakpoint set at line 5
The breakpoint tells the simulator to stop at that instruction. Note that you may not set a breakpoint on a
directive; only on an actual instruction.
Now when you click on the Debug Main Program button, after a few machinations the program will stop
at the line that used to be red. The green arrow on the left shows where the program counter stopped, and
that line is also now highlighted in green.

Figure 12. Program stopped at line 5
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At this point, we have started our program, but we haven't yet executed the first instruction. In the toolbar
are two boxes with cryptic letters in them:

Figure 13. Processor registers boxes
These two boxes show us key registers in the PIC.
For now, we are interested in only two things: the PC: value and the W: value. PC stands for program
counter. This is the address of the next instruction to be executed. W stands for the contents of the working
register, or W register. This is the register where almost everything is done.
Now, if we click the Step Into button, a number of things happen. Most obvious, the green line moves
down a line, uncovering the red above it. But notice that the PC has changed to 0x1 from 0x0, and the W
has changed from 0x0 to 0x5.
We executed the movlw D'5' instruction, which moves the value 5 into the W register. movlw stands for
"move literal into W". Since we executed the instruction at location 0, the next instruction is at location 1,
which is why the PC changed to 0x1. The D'5' stands for decimal 5. Decimal 5 is also hexadecimal 5, so
the value after W changed to 0x5.
Since we often want to step through multiple instructions, one at a time, the Step Into button has a
shortcut available, F7. If we press the F7 key, the green line and arrow will again move down a line, the
PC will update to 0x2, and the W will now show 0x0. The clrw instruction stands for "Clear the W register",
which is exactly what happened.

3.6. Some more playing with the simulator
Now add a few more lines so our program looks like this:

Figure 14. Add a few more lines
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Some more playing with the simulator
Select the file register display from the menu Window -> Pic Memory Views -> File Registers.

Figure 15. Select the file register display
In the lower right pane a display will appear similar to

Figure 16. File Register Display
The file registers are where everything that changes is stored. The first 32 addresses, 0x00 to 0x1f, are
various registers, most of which control peripherals. Addresses 0x20 and above are memory locations to
be used by the program. Recall that we wanted to use location 0x30 (or H'30') to store some calculation
results. To make it easier to refer to this location, we associated the address with the name Spot1. All the
equ instruction does is provides a way of referring to a number, in this case, an address, by a name. We
could have said movwf 0x30, but as we start to use more file register locations, it is handier for each to
have a name rather than remembering all the addresses.
Once again, place a breakpoint at the movlw D'5' instruction and start debugging. As before, with the
first single step we will see the W register change to 5. But this time, when we step again, location 0x30
in the file register display will turn red and the value will change to 5. Note that every time you step, and
changes in the file register display are highlighted in red.
The next step clears the W and another step resets file register location 0x30 to zero. Also notice that each
time you single step, location 0x02 changes. This is the program counter or PC register.
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Simulator clears file registers
When the simulator is started, all file register locations are cleared. In the actual hardware, file
register locations are random on startup. Clearing the file registers does make some debugging with
the simulator a little simpler, but it can be misleading if you expect a location to be clear on startup.

3.7. Let's do some Arithmetic
OK, so we've loaded a number into both the working register and the file registers. Now let's do a little
something with those values.
Change our program yet again to look like this:

Figure 17. Add some arithmetic statements
(Old lines have been grayed.)
Now as we step through the program, we will see us storing the 5 in Spot1 like before, but then we will
load a 2 into the W register, and add it to Spot1, then store the result in Spot2. Next, we will move a 3 into
the W register, subtract that from Spot2, and store the result in Spot1.
Notice the ,W on the add and subtract instructions. These instructions can store the result either into the
W register, or the original memory location. If we had wanted the result to go back into the file register, we
would have used ,F instead of ,W.
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The diff display

3.8. The diff display
At this point, it is worth pointing out the diff display in MPLAB-X. Clicking on the History button on the top
of the code tab will present a list of dates. Selecting the most recent date should give a display similar to:

Figure 18. Diff display
This display shows differences between the saves we have done in this session. Sometimes something
will go wrong and we won't recall just which edit may have caused it. This display helps us find those
issues.
The drop down next to Compare mode: allows us to select whether we wish to see differences between
the selected date/time and the current version, or differences between adjacent versions.
The display only shows edits made this session. MPLAB-X can be integrated with another tool called
git, which allows comparisons across sessions. git is a very powerful tool if you start to do more complex
projects, but its use is beyond the scope of this course.

4. Helping to Understand Our Program
4.1. Introduction
So far, we've worried only about the specific instructions that make up the program. As we develop
programs, they can get to be a little long. We need some aid in understanding the program, especially
when we come back to it after being away a few days, or weeks.

4.2. Comments
The assembler allows us to put comments in our code. Whenever the assembler encounters a semicolon,
everything after that on the same line is ignored. The assembler also allows us to have lines that are
entirely blank, which can help us with readability.
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The following assembly is exactly equivalent to what we had before:

Figure 19. Comments
Notice something else here. The second column is all blue, directives a lighter blue than instructions.
MPLAB colors PIC instructions and assembler directives that it recognizes as blue. The instructions are
bold, while the directives are not. Comments are colored green. If we type in something and it shows up
the wrong color, this is a red flag (well, maybe a purple flag) that perhaps we fat-fingered something.

5. Incrementing and Decrementing
5.1. Introduction
Over and over again in our programs we need to increment or decrement a counter. The PIC provides a
number of instructions for this. First, let's look at the incf and decf instructions.
Like the addwf and subwf instructions, the incf and decf instructions take a memory location and a
destination as operands.

5.2. Adding to our Program
Add the following 4 lines to the program near the end, just above the NOP instruction:
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Testing

incf
incf

Spot1,F ; Bump up Spot1 twice
Spot1,F ;

decf
decf

Spot2,F ; And bump down Spot2
Spot2,F ;

and assemble the program to test for typos.

5.3. Testing
Now, we have a lot of stuff in our program that we already know works, and we don't really want to go
stepping through the whole thing again. So this time, set a breakpoint at the first incf instruction. This
way all our previously tested code will run and the simulator won't stop until it gets to the code we wish to
test.
Notice that you may set the breakpoint either by clicking on the line number as we didi earlier, or by rightclicking the line of code and selecting Toggle Line Breakpoint.
Now, as before, open the File Register window and click on the Debug Main Project. This time the
program will run right past all the tested code and stop at the first incf instruction.
Now we can single-step through the remaining instructions like we did earlier, and see that the Spot1
location (0x30 in the file register) gets incremented twice, and then the Spot2 (0x31) location gets
decremented twice, just as we would expect.

Figure 20. File register after increments and decrements
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6. Bit Manipulation
6.1. Introduction
Lots and lots of times, especially when we are doing embedded applications, we need to manipulate
individual bits within a byte, or perhaps parts of bytes. The PIC provides a complete set of bit manipulation
instructions, which we will explore here.

6.2. Another Project
Rather than continuing on with our previous program, let's make a new project. This time, call the project
Lesson4b and the assembler source Lesson4b.asm.
Let's be boring and start the program off with our favorite four directives, and yes, let's add in our nop
instruction for now.

6.3. AND
Before the nop, first define a file register location, let's be real creative and call it Loc1, then load the
working register with a 7, save it in Loc1, then load the working register with a 12:

Figure 21. Initial Lesson4b
Now, asemble the program, set a breakpoint, click Debug Project, and step through the program. You
should see no surprises. Each of these instructions works as they did before. Now, before the nop, add

andwf

Loc1,W

Now when we step through the program (after assembling it, of course), what do you suppose will happen
to the W register? If you skipped ahead and ran the simulator already, you see the result was 4. But why?
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Looking at values in different formats
The andwf instruction told the processor to perform a bitwise AND of the contents of the W register with
the contents of Loc1, and place the result in the W register. This means the whenever a bit is on in both
the W and Loc1, the corresponding bit in W will be turned on:

Figure 22. Individual bits
Like other instructions that combine the W register and the file register, we can store the result in the file
register. Change the ,W on the andwf instruction to a ,F and observe the result.
Notice that the W register remains a 12 (0xc), but file register location H'30' is set to a 4.
Most often, we use the AND function to turn off specific bits or groups of bits. For example, if we wanted to
turn off the low order 2 bits in a number, we could AND it with B'11111100' (H'fc'). The result would be the
same as the original, except with the rightmost two bits turned off.

6.4. Looking at values in different formats
The File Register window allows us to see all the data we may have stored, but it only shows us in
hexadecimal. Sometimes it would be nice to see those locations in other formats; in particular right now it
would be helpful to see the binary.
On the Window menu, roll down to Debugging and select Variables Alt+Shift+1. We will get a window
similar to Figure 23, “Variables Window”. Because we are doing an absolute assembly, we don't actually
have any proper variables. But we do have some addresses we care about.
Click on Enter new watch (don't double-click, that will get a different window). Enter the address of the
value we are watching, 0x30. The value will be displayed in the Value column.

Figure 23. Variables Window
We may enter as many locations as we wish.
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Now, right-click on the line containing the value of interest, roll down to Display Value Column As and
select Binary. The value for the location will be displayed in binary.

Figure 24. Select binary value display
This is much handier when we are exploring the various bit operations. At other times, other formats might
be useful.

6.5. Inclusive OR
The inclusive OR is almost the exact opposite of the AND. For a result bit to be on, either of the source
bits may be on. Let's try it. Before the nop add:

iorwf

Loc1,F

Since the working register was H'0c' and Loc1 was a 4, the result, stored at Loc1, was a H'0c'. Ok, not so
satisfying, so lets add a:

movlw

D'3'

before our iorwf. Now we would expect Loc1 to contain a 7 (3 IOR 4) when we are done. Try it.

6.6. Exclusive OR
The exclusive OR works just like the inclusive OR, except that a bit will be false if both operands are true.
At the end of the previous experiment, Loc1 should have contained a 7, while W contained a 3. Add three
lines before the nop:

xorwf
xorwf
xorwf
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Loc1,F
Loc1,F
Loc1,F

Complementing
Notice when we step through this, the low order 2 bits of Loc1 toggle, first off, then on, then off again. This
is easier to see if you select the Symbol format of the File Registers view where you can see the decimal
and binary representations as well as the hexadecimal representation of Loc1:

Figure 25. File Register Display - Symbol Format
As in Figure 23, “Variables Window”, the symbol, Loc1 is not displayed since the assembler really doesn't
know that it refers to a memory location, it is merely a name for a number.

6.7. Complementing
Sometimes we want to invert all the bits. The comf instruction does this for us. It would be just like xorwf
if the W register contained a H'ff', but we don't need to use the W register.
Again, add to our program:

comf

Loc1,F

before the nop. Notice that all the bits get inverted, but the W register is unchanged. If we wanted, we
could have had the result placed in the W register, which would have left Loc1 unchanged.

6.8. Bit set and clear instructions
The final two instructions bcf and bsf, set and clear an individual bit in a file register location. Unlike the
other logic instructions, these instructions take a bit number as an argument.
At the end of our program, just before the nop, add:

bcf
bcf
bcf

Loc1,0
Loc1,1
Loc1,2

These instructions are especially useful on the I/O ports, when we want to change the state of a particular
pin, without having to concern ourselves with the states of all the other pins.
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7. The Simulator
7.1. Introduction
We dove right in and started using this Simulator thing, but what is it, anyway?

7.2. The Simulator
The MPLAB is an Integrated Development Environment or IDE. It's actually a shell that runs a number of
other programs in a fairly seamless way. We've used the editor pretty extensively without talking much
about it. We could have used any old editor we like. We've also used the assembler. When we installed
MPLAB, we got a choice added to our Start menu that allows us to run the assembler separately. If we
wanted, we could have edited our source files in Notepad, and run the assembler from the Start menu.
The Simulator is yet another program we run from the IDE. It takes the assembly results and pretends to
be a PIC. It interprets the PIC codes and does what they say to do, as if it were a PIC. This interpreting
business is complicated, though. In spite of the fact that our PC is probably 100 times faster than a PIC,
the simulator runs many times slower than a real PIC.

7.3. Why would we do such a thing?
When we run a program in a PIC, itâ's pretty hard to see what is going on. We have no way to examine
the registers, and most PIC programs have fairly few outputs that are satisfying to watch. We could
include instructions in our program to wiggle some line or another to let us know where it is, and then
follow those lines with a scope or perhaps attach an LED to the line, but this is pretty clumsy.
By pretending to be a PIC, the simulator lets us run the program and see inside. We've already seen how
we can step through one instruction at a time, examine the registers, and even have the program run until
a particular instruction.
What we haven't seen (yet) is how we can change the values in the registers and see how our program
reacts, or simulate different types of stimuli on the I/O pins to allow us to work through our program's logic.
The simulator is a very powerful tool for debugging our programs. In the early lessons in this course, we
will use the simulator because we haven't developed the skills needed to debug our program in actual
hardware. As we get more proficient, we will test programs on the actual PIC, but even then, we will find it
helpful to run our program, or parts of it, on the simulator so we can see what's going on.

7.4. About the nop
The other little detail we never mentioned is that nop instruction we keep putting at the bottom of the
program. That is actually for the simulator. In a real PIC program, we would never let the program reach
the end directive. To do so would allow the PIC to start executing code in a part of memory where we
never stored anything. The results are unlikely to be satisfying, and likely to be unpleasant!
To simulate this behavior, the simulator goes off into never never land when it executes the end directive.
As a consequence, we wouldn't be able to see the result of our last instruction. The nop gives us a little
room.
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It would probably be better to use something like:

A

goto

A

But we haven't talked about goto yet.

8. Instruction Set Help
8.1. Introduction
Over the next few lessons, we will explore many of the "midrange MCU" instructions. However, these
lessons won't be arranged to make a convenient reference. There are a number of sources for more
complete information.

8.2. Family Reference Manual
The "PICmicro™ Mid-Range MCU Family Reference Manual" (DS33023A) is the primary source for
details about the instruction set of the PIC16 processors. However, this is an extensive (almost 700 page)
detailed manual. It is, nevertheless, a good document to have handy.

8.3. Help Files
Fortunately, MPLAB-X has some very good help for the kinds of information you need most frequently.
There is actually a huge amount of help included with MPLAB-X. To access the help, select Help
Contents from the Help menu:

Figure 26. Help Menu
A rather lengthy list will appear.
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Double-click MPASMX Toolsuite to expand it, then expand Reference and finally Instruction Sets.
Highlight 14-bit Instruction Width Instruction Set.

Figure 27. Instruction Set Help
The help is arranged by category of instruction in 3 tables showing the instruction hex code, the mnemonic
along with whether there are F andW flags, and prose and symbolic descriptions of what the instruction
does.
This isn't the best tutorial, we will approach it differently in the next few lessons, but when you know what
you are looking for, this help page can be an effective memory jogger.
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9. Wrap Up
9.1. Summary
In this lesson, we have experimented with those instructions that manipulate the working register and the
file registers, but have few other effects. This group of instructions comprises fully half of the PIC 16F628A
instruction set.
We have also used the simulator to see what those instructions did. The simulator will be our primary tool
for understanding our programs as we go forward.

9.2. Coming Up
So far, our instructions have done things, but there has been no way to make decisions. Using what we
have learned, all our programs have to go in a straight line, and do exactly the same thing every time.
In the next lesson, we will look at some instructions that affect the status register, and instructions that
allow us to test the status register. This is where we start to be able to develop some interesting behavior.
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